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ABSTRACT
The NMT-5 Criticality Database maintains criticality-related data and
documentation to ensure the safety of workers handling special nuclear
materials at the Plutonium Facility (TA-55) at Los Alamos National
Laboratory. The database contains pertinent criticality safety limit
information for more than 150 separate locations at which special nuclear
materials are handled. Written in 4th Dimension for the Macintosh, it
facilitates the production of signs for posting at these areas, tracks the
history of postings and related authorizing documentation, and generates
in Microsoft Word a current, comprehensive representation of all signs and
supporting documentation, such as standard operating procedures and
signature approvals. It facilitates the auditing process and is crucial to full
and effective compliance with Department of Energy regulations. It has
been recommended for installation throughout the Nuclear Materials
Technology Division at Los Alamos.
________________________________________________

I.

INTRODUCTION

Radiological workers inside the Plutonium Facility (TA-55) at Los Alamos National Laboratory use
glove boxes to handle large quantities of special nuclear material (SNM). For tracking purposes, each
glove box, or other SNM handling area, is referred to as a MASS (for Materials Accountability and Security System) location. Currently, the Weapon Component Technology Group (NMT-5) has the responsibility for approximately 150 MASS locations throughout its work areas within the Plutonium Facility. Each
MASS location's criticality limits are documented on a Criticality Safety Limit Approval (CSLA) form.
One or more signs posted at each MASS location list the criticality limits applicable to that location.
Approximately 250 signs, consisting of 24 different sign types, are in place at the 150 MASS locations.
The appendix to NMT-5 administrative procedure 002-APP, NMT-5 Criticality Safety, contains copies of
all signs. Each MASS location may also have applicable Safe Operating Procedures (SOPs) that provide
instruction as to the correct use of that MASS location.
Previous generations of criticality limit signs were prepared manually and with Autocad. The signs
were then photocopied for incorporation into NMT-5 administrative procedure 002-APP as an appendix.
The CSLA forms were prepared manually. This manual approach, while sufficient, presented two significant problems: a significant amount of time was required to create each sign, CSLA form, and appendix
document and the potential for human error was great.
The NMT-5 Criticality Database was conceived to ease the management of criticality information
and the maintenance of the criticality limit signs and their associated documentation. The database is written in 4th Dimension (4D), a relational database for the Macintosh. This tool provides powerful search
and sort capabilities that facilitate auditing of the posted signs. The database stores all information for
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each MASS location's CSLA forms and signs. Printing the CSLA forms and signs is easily accomplished
from the database, which can also be used to generate the appendix in Microsoft Word format.
The creation of the appendix illustrates the complexity of the documentation requirements and demonstrates the ability of the database program to facilitate the process by automation. The appendix consists
of a “chapter” for each room that has MASS locations (Fig. 1). Each “chapter” begins with an alphabetized list of the room’s MASS locations. The remainder of each “chapter” consists of a graphic (one per
page) showing each sign. The sign pages appear alphabetized by sign name within each chapter.

appendix

...

Fig. 1. Organization of administrative procedure 002-APP, NMT-5 Criticality Safety.
Before the database was developed, creation of the appendix required that each of the approximately
250 signs be photocopied and manually inserted into the final document. For each room, the user identified and sorted the room's MASS locations, created its alphabetized MASS location list, and created and
properly inserted each sign page into the document. Manually creating this large document was time-consuming and potentially error-prone. Using the database to create this document saves time and ensures
document accuracy.

II. DATABASE DESIGN
A. Relational Structure
The database is designed around MASS locations—the primary goal being the management of the
signs, SOPs, and CSLA forms associated with each MASS location managed by NMT-5. For each MASS
location the user of the database must be able to assign and retrieve the associated signs and SOPs for that
MASS location. The user must also be able to determine the MASS locations for which a single SOP
applies. A MASS location must have at least one sign and may have no or many SOPs. Figure 2 shows the
primary organizational structure for the database. The arrows represent the relationships between the
major database areas.

Signs

has

MASS
Location

has
many

Fig. 2. Organization of primary database.
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SOPs

B.

Signs

The database contains information necessary to print the sign or signs for each MASS location. This
information is also used to generate the appendix document. Because many signs share the same format,
signs are categorized by sign type. An example of a common sign is shown in Fig. 3.
The information appearing below the title “CRITICALITY LIMITS” is unique to the MASS location
This unique information consists of the MASS location and the location or workstation diagram, which
may detail an entire glove box, part of a glove box, a safe drawer, or a floor location such as a diagnostic
instrument. Currently, there are 24 sign types in the database; an example of each is provided in
Appendix A. For some sign types, many signs exist; for others, only one sign exists.
For each sign, the following information is stored:
• unique identifier,
• MASS location,
• diagram,
• sign type, and
• sign date.
For each sign type, the following information is stored:
• unique identifier and
• special instructions for using the sign type.
The sign type is used to determine the background used when printing the sign. Each of the 24 sign
types has a specific background. The sign’s diagram is placed on this background in a predetermined location. A sign type’s special instruction is used for issuing guidance when printing a sign. For example,
some signs require printing on special colored paper. Special instructions, such as those alerting the user
to print on special colored paper, appear before these signs are printed.

CRITICALITY LIMITS

Diagram

R
R
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COMPLY WITH RESTRICTIONS.
• For mixtures of SNM FORMS use the LOWEST criticality limit.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams
or less

No restrictions as to form,
solution, volume or equipment

OR
Plutonium in metal*

4500 grams maximum

OR
Plutonium in oxide or
nonhydrogenous compounds*

4500 grams maximum per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes*

6000 grams maximum

*Container of used RAGS up to 4 liters volume stored 6-8 inches from
metal parts is permitted.

NMT-5

5/4/94

Fig. 3. Example of MASS location sign.
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C. MASS Locations
For each MASS location, the following information is stored:
• unique MASS location identifier and
• room number.
Signs and SOPs related to MASS locations are indicated by the unique mass location identifier.

D. SOPs
For each SOP, the following information is stored:
• date,
• unique SOP identifier,
• title,
• author, and
• expiration date.
Having this SOP information enables the user to locate documents based on when they were written
(or put into service), identify SOPs written by a certain author, and easily identify SOPs that have expired.

E.

CSLA Forms

A CSLA form is the parent documentation of approval for criticality safety limits for a particular
MASS location and includes the required signatures. The generic limits and formats for the signs are specified by administrative document 522-GEN, NMT Criticality Safety.
For each CSLA form, the following information is stored:
• the date the form was requested,
• the name of the person who requested the form,
• the identifier of the MASS location the form applies to,
• the room number where the form’s MASS location resides,
• a process description for the MASS location,
• a list of possible hazards for the MASS location’s process,
• a list of the effects the MASS location’s process has on or receives from adjacent operations,
• a list of proposed changes to the MASS location's criticality safety limits,
• limits to types and amounts of material that can pass through the MASS location,
• a list of all SOPs that apply to the MASS location, and
• a diagram of the MASS location’s principal sign.
When a CSLA form is created in the database, it stores current information for a MASS location. If a
MASS location’s information changes, the CSLA form for that MASS location does not automatically
change in the database. Therefore, one MASS location may have many CSLA forms. Each of these forms
reflects the state of a particular MASS location at a specific point in time. When printed, a CSLA form has
a signature and date area. Once signed and dated, the form becomes a permanent record of the MASS
location’s state at the time of signing.

III. DATABASE FUNCTIONALITY
Because the database runs on a Macintosh computer, information is accessed through a graphical
user interface. The user navigates through the database by selecting an appropriate menu. There are three
main menus: File, Edit, and Select (Fig. 4).
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Fig. 4. File menu.

A. File Menu
The File menu enables the user to access the major database functions. Available menu items for data
entry and display are MASS Locations, SOPs, CSLA Forms, and Signs. Additional menu items are available for printing signs, generating the Microsoft Word appendix document, and accessing 4D Draw.
1. MASS Locations Menu Item. The MASS Locations menu item enables the user to view a list of
all MASS locations in the database. From this list the user can choose and modify an existing MASS location or create a new one. The list displays each MASS location and its room number (Fig. 5).

Fig. 5. MASS Locations List Window.

5

New MASS locations (Fig. 6) can be added to the database, and sign types, diagrams, and SOP information can be entered. The sign diagram is created with a drawing program, such as 4D Draw or
MacDraw Pro, and pasted into the diagram window. The Signs list can be scrolled to accommodate as
many signs as needed. Any existing SOP can be added to the SOP list. This list can be scrolled to accommodate as many SOPs as needed.
2. SOPs Menu Item. The SOPs menu item enables the user to view a list of all SOPs in the database.
From this list the user can choose and modify an existing SOP or create a new one. The user can also easily query the database for expired SOPs. The list displays each SOP by date, identifier, title, author and
expiration date (Fig. 7).
New SOPs can be added to the database using the entry window shown in Fig. 8. This window is also
used to modify existing SOPs. Any existing MASS location can be added to the MASS Location list. This
list can be scrolled to accommodate as many SOPs as needed.
3. CSLA Forms Menu Item. The CSLA Forms menu item enables the user to view a list of all
CSLA forms in the database. From this list the user can choose and modify an existing CSLA form or create a new one. The user can also print selected CSLA forms from the list. The generic limits and the format for the signs are specified by administrative document 522-GEN, NMT Criticality Safety. The CSLA
form is the parent document for the signs for each MASS location and includes the required signature
approvals. The list displays each CSLA form by MASS location, room number, applicable SOPs, date,
and requestor (Fig. 9).
New CSLA forms can be added to the database using the entry window shown in Fig. 10. This window is also used to modify previously entered CSLA forms. Note that because a CSLA form is a record of
a MASS location at a particular point in time, modification of an existing CSLA form would occur only
before signature approval. The CSLA Forms Entry Window allows data entry for request date, requestor,
MASS location, process description, hazards (of process), effects (of process on or by adjacent operations), proposed change (in limits), pass-through limits, diagram, and SOPs used in the MASS location.
An example of the CSLA form is shown in Fig. 11. The database contains all of the information required
for this document and enables the user to search and sort for all fields on the form.

Fig. 6. MASS Locations entry window.
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Fig. 7. SOPs list window.

Fig. 8. The SOPs entry window.
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Fig. 9. CSLA Forms list window.
4. Signs Menu Item. The Signs menu item enables the user to view a list of all Signs in the database.
From this list the user can choose and modify an existing sign or create a new one. The Signs List Window
displays the sign identification, MASS location, sign type, and sign date (Fig. 12). For inventory purposes, the signs can be sorted by room to show the sign identification, MASS location, sign type, sign
date, and diagram and then printed.
New signs can be added to the database using the entry window shown in Fig. 13. This window is
also used to modify existing signs. Users can modify the diagram using 4D Draw by clicking the edit diagram button. The 4D Draw diagram edit window is shown in Fig. 14.
5. Print Signs Menu Item. The Print Signs menu item enables the user to select and print the actual
MASS location signs using the information stored in the database. The selection of signs to print is created by using 4D’s search editor. The standard search fields are MASS location and room number, but the
user can also search by other fields such as sign identifier or sign date. Some sign types are printed on red
paper; an alert appears on the screen if the signs selected for printing are of these sign types so the user
can load the correct paper in the printer before printing.
6. Microsoft Word Appendix Menu Item. The Microsoft Word Appendix menu item enables the
user to generate the appendix of NMT-5 administrative document 002-APP, NMT-5 Criticality Safety.
This appendix contains copies of all criticality limit signs. The appendix is organized alphabetically by
room number. Each sign is a graphic that occupies one page of the document, and each room is a
generated as a separate appendix file. The files are then linked to form the complete appendix. The current
appendix has approximately 250 pages. Generation of the complete appendix requires about 20 minutes
and a sizable portion of the Macintosh resources, but this resource requirement is far less than the cost of
the many person-days required for manual generation of the appendix.
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Fig. 10. CSLA Forms entry window.
Before generation starts, the user is presented with an option to selectively generate the appendix for
specific rooms. While appendix generation is in progress, a status window appears so that the user can
monitor progress. When generation is complete, the database produces a report. This report contains
information that will assist the user in assembling the complete appendix document. For each room, the
following information is reported:
• the name of the generated file,
• whether or not the room’s appendix was generated,
• the number of pages in the room’s appendix file, and
• the beginning and ending page numbers for the generated appendix relative to the overall document.
7. 4D Draw Menu Item. The 4D Draw menu item allows the user access to 4D Draw, 4th Dimension’s powerful object-oriented drawing package. The user can use this feature to create sign diagrams or
as a stand-alone drawing package for creating graphics for other applications. The 4D Draw window is
shown in Figure 16.

B.

Edit Menu

This menu provides the standard Macintosh editing features: Undo, Cut, Copy, Paste, Clear, Select
All, and Show Clipboard. Items in this menu appear enabled or disabled, depending on the action being
performed.
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NMT-5
CRITICALITY
SAFETY
LIMIT
APPROV
AL
NMT-5 CRITICALITY
SAFETY
LIMIT
APPROVAL

Room Number/MASS Location

Change Requested by

113 / D109

B. CORT

Date 04/24/94

Standard Operating Procedure Numbers
(Include all SOPs that apply to the workstation.)
364-CHA-RXX "DENSITY OF PLUTONIUM USING BROMOBENZENE"

Brief Description of (each) Process:
STORAGE, ISOMET SAW, IMMERSION DENSITY
Hazards: CONTAMINATION, CRITICALITY, FIRE, IONIZING RADIATION, TOXIC
CHEMICALS
Effects on or from Adjacent Operations:
NONE
Proposed Change in Criticality Limit:
520 g/no restrictions; Pu metal/4500 g; Pu oxide or nonhydrogenous compounds/3000 g
per container, 9000 g maximum; Pu in approved metal shapes/6000 g
Pass-Through Limits:
520 g/no restrictions; Pu metal/4500 g; Pu oxide or nonhydrogenous compounds/3000 g
per container, 9000 g maximum; Pu in approved metal shapes/6000 g
Diagram of Work Station:

D109
Reviewed by

Date

Reviewed by
Date
Group Section Leader

Date

Approved by

Group CSO
Reviewed by
ESH-6

Date
Group Leader

Fig. 11. CSLA Form example.
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Fig. 12. Sign List window.

Fig. 13. Signs entry window.
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Fig. 14. Signs Diagram edit window.

Fig. 15. Appendix Generation Status window.

C. Select Menu
The Select menu is used when working with MASS Locations, SOPs, CSLA Forms, and Signs. The
items in this menu allow the user to easily find and arrange information for these four database areas.
Because the database allows the user to work with more than one of these areas at a time, the Select menu
items always apply to the frontmost window.
Show All restores the list of records to all of the file’s records. The records appear in the order they
were entered and saved in the database.
Show Subset enables the user to select individual records in a list. Choosing Show Subset reduces the
listed records to those selected.
Search Editor... opens 4D’s search editor. The user uses the search editor to find records that meet
certain user-specified criteria.
Sort Editor… opens 4D’s sort editor. The user uses the sort editor to determine the order that records
appear in the record list.
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Fig. 16. 4D Draw window.
Print Selection sends the selected records to the printer. Records are printed using defined report formats.
Delete Selection deletes selected records from the database. The user is given the option to cancel the
deletion.

IV. SUMMARY
The NMT-5 Criticality Database is a powerful tool for maintaining criticality-related data and documentation. It enables NMT-5 staff to easily produce and manage MASS location signs and the supporting
documentation necessary for compliance with regulations of the Department of Energy and other agencies. It is designed to be user-friendly. Its search and sort capabilities provide ready access to pertinent
information regarding criticality limit signs, which can be easily and quickly updated, produced, and
posted. Generation of the appendix document is now simple and accurate, whereas in the past it was a
tedious, time-consuming task.
The database facilitates audit of the signs and their supporting documentation. Reports that assist site
audits can be produced quickly and used on the floor to ensure that MASS location signs and SOPs are
present and correct. The database offers a complete approach for meeting regulatory requirements. The
development and use of the database and the compliance methodology it supports have established
NMT-5 as a criticality safety compliance leader within the Nuclear Materials Technology Division at Los
Alamos National Laboratory, and the division director has suggested that the database be installed
throughout the division.
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APPENDIX A
THE NMT-5 CRITICALITY DATABASE
SIGN TYPES
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I.

SIGN TYPES

This appendix shows each of the 24 sign types supported in the NMT-5 Criticality Database.
Signs that have diagrams show the diagram placement location.
Sign Type 1

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For mixtures of SNM FORMS use the LOWEST criticality limit.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams
or less

No restrictions as to form,
solution, volume or equipment

OR
Plutonium in metal*

4500 grams maximum

OR
Plutonium in oxide or
nonhydrogenous compounds*

4500 grams maximum per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes*

6000 grams maximum

*Container of used RAGS up to 4 liters volume stored 6-8 inches from
metal parts is permitted.
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Sign Type 2

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FO RMS use the LOWEST criticality limit.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams
or less

No restrictions as to form,
solution, volume or equipment

Sign Type 3

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FORMS use the LOWEST criticality lim it.

FORMS

RESTRICTIONS

Plutonium in solution and other
hydrogenous m aterials

1500 grams maxim um

OR
Plutonium in m etal

1500 grams maxim um
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Sign Type 4

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FORMS use the LOWEST criticality lim it.
• FREEZER: Tunnel storage m ust be CLO SED when other
SNM is passed through.
FO RMS

RESTRICTIO NS

Plutonium totaling 520 grams or
less

No restrictions as to form ,
solution, volume or equipment

OR
Plutonium in metal

4500 grams maximum

OR
Plutonium in oxide or
nonhydrogenous compounds

4500 grams maximum per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes
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6000 grams maximum

Sign Type 5

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FO RMS use the LOWEST criticality limit.
• HOOD: NO STORAGE ALLOWED
FORMS

RESTRICTIONS

Plutonium totaling 520 grams or
less

No restrictions as to form ,
solution, volume or equipment

OR
Plutonium in m etal

4500 grams maxim um

OR
Plutonium in oxide or
nonhydrogenous compounds

4500 grams maxim um per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes

6000 grams maxim um
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Sign Type 6

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.

FORMS

RESTRICTIONS

Plutonium in metal

4000 grams

Sign Type 7

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• No more than one press to be operated at one tim e, but either
press may be used.
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FORMS

RESTRICTIONS

Plutonium in m etal

2000 gram s

Sign Type 8

PASS-THROUGH LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• MAXIMIZE spacing between SNM assigned to the workstation
and the SNM being passed.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams or
less

No restrictions as to form,
solution, volume or equipment

OR
Plutonium in metal

4500 grams maximum

OR
Plutonium in oxide or
nonhydrogenous compounds

4500 grams maximum per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes

6000 grams maximum
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Sign Type 9

CRITICALITY LIMITS
FOR SAFE
PF4-114
677473

A-D

NORTHWEST
PF4-114
S114
A
B
C
D

SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 10
CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For mixtures of SNM F ORMS use the LOWEST criticality lim it.
• MAXIMIZE SPACING.
• NO STACKING.
FORMS

RESTRICTIONS

Plutonium totaling 520 grams or
less

No restrictions as to form,
solution, volume or equipmen t

OR
Plutonium in m etal

4500 grams maxim um

OR
Plutonium in o xid e or
nonhydrogenous compounds

3000 grams maxim um per
container with a maximum of
9000 grams

OR
Plutonium in approved metal
shapes

6000 grams maxim um
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Sign Type 11

CRITICALITY LIMITS
FOR SAFE
PF4-329
836280

SF16-SF19

NORTHEAST
PF4-329

SF16
SF17
SF18
SF19
SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 12

CRITICALITY LIMITS
FOR SAFE
PF4-329
836278

SF20-SF23

NORTHEAST
PF4-329

SF20
SF21
SF22
SF23
SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 13

CRITICALITY LIMITS
FOR SAFE
PF4-329
836277

SF24-SF27

NORTHEAST
PF4-329

SF24
SF25
SF26
SF27
SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 14

CRITICALITY LIMITS
DIEBOLD SAFE
SF01

SF02

SF03

SF04

SF05

SF06

SF07

SF08

SF09

SF10

SF11

SF12

SF13

SF14

SF15

SEE INDIVIDUAL DRAWER
FOR CRITICALITY LIMITS
Sign Type 15
CRITICALITY

LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS
• For mixtures of SNM FORMS use the lowest criticality limit.
• SAFE: Drawer contains THREE MASS locations; EACH
location has the limits listed below.
FORMS

RESTRICTIONS

PITS

SNM Value of one PIT
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Sign Type 16

CRITICALITY LIMITS
FOR SAFE
PF4-317
711085

1- 4

NORTHWEST
PF4-317
S317
1
2
3
4

SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 17

CRITICALITY LIMITS

A
B
C

F
F329

SEE INDIVIDUAL LOCATIONS
INSIDE CAGE FOR LIMITS
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Sign Type 18

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FO RMS use the LOWEST criticality limit.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams
or less

No restrictions as to form,
solution, volume or equipment

OR
Plutonium in m etal*

4500 gram s m axim um

OR
Plutonium in oxide or
nonhydrogenous compounds*

4500 gram s m axim um per
container with a m axim um of
9000 gram s

OR
Plutonium in approved metal
shapes*
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6000 gram s m axim um

Sign Type 19

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For m ixtures of SNM FO RMS use the LOWEST criticality limit.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams
or less

No restrictions as to form,
solution, volume or equipment

OR
Plutonium in m etal*

4500 gram s m axim um

OR
Plutonium in oxide or
nonhydrogenous compounds*

4500 gram s m axim um per
container with a m axim um of
9000 gram s

OR
Plutonium in approved metal
shapes*

6000 gram s m axim um

*Container of used RAGS up to 4 liters volume stored 6-8 inches from
metal parts is permitted.
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Sign Type 20
CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS.
• For mixtures of SNM FORMS use the LOWEST criticality limit.
• SAFE: Drawer contains TWO MASS locations separated by a
file divider; EACH location has the limits listed below.

FORMS

RESTRICTIONS

Plutonium totaling 520 grams or
less

No restrictions as to form, solution,
volume or equipment

OR
Plutonium in metal

4500 grams maximum

OR
Plutonium in oxide or
nonhydrogenous compounds

3000 grams maximum per container
with a maximum of 9000 grams

OR
Plutonium in approved metal
shapes

6000 grams maximum

Sign Type 21
CRITICALITY

LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS
• For mixtures of SNM FORMS use the lowest criticality limit.
• SAFE: Drawer contains THREE MASS locations; EACH
location has the limits listed below.
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FORMS

RESTRICTIONS

PITS

SNM Value of one PIT

Sign Type 22

CRITICALITY LIMITS
FOR SAFE
PF4-327 674448

1-4

NORTH
PF4-327
S327
1
2
3
4

SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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Sign Type 23

CRITICALITY LIMITS

Diagram Location

COMPLY WITH RESTRICTIONS
• For mixtures of SNM FORMS use the LOWEST criticality limit.
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FORMS

RESTRICTIONS

PIT

SNM Value of one PIT

Sign Type 24

CRITICALITY LIMITS
FOR SAFE
PF4-113 676645

A-D

NORTH
PF4-113
S113
A
B
C
D

SEE SAFE FOR INDIVIDUAL
CRITICALITY LIMITS
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